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Read Me First

Read this section before continuing with the rest of the guide.

Warnings

In all NDI documentation, warnings are marked by this symbol. Follow 
the information in the accompanying paragraph to avoid personal 
injury.

1. The power adapter must be located outside the patient environment 
under all operating conditions. It is the responsibility of the system 
integrator and/or the end-user to ensure that the system is 
appropriately configured for the operating conditions.

2. Position the system components so that they can be easily 
disconnected from mains power. Failure to do so may result in an 
electric shock hazard and possible personal injury.

3. Do not use a power bar or extension cable to connect the power 
adapter to the mains supply. Doing so may result in an electric shock 
hazard and possible personal injury.

4. Make sure the power adapter is connected to a mains supply with 
protective earth. Failure to do so may result in an electric shock 
hazard and possible personal injury.

5. Do not touch the subject and metal parts of the system at the same 
time. Doing so may result in an electric shock hazard and possible 
personal injury.

6. There are no user serviceable parts in the Krios System. All servicing 
must be done by NDI. Unauthorised servicing may result in personal 
injury.

7. Do not immerse the Krios System in liquids, or allow fluid to enter 
the equipment in any way. Exposing the Krios System to liquids may 
result in equipment damage, produce a fire or shock hazard, and 
result in personal injury.

Warning!
iv Krios User Guide - Revision 03



8. Switch off power to the Krios System before cleaning it. Failure to 
do so may result in personal injury.

9. The laptop power adapter that is certified with this device is Lenovo 
42T4430. If a different laptop/computer is used, the power adapter 
must be IEC 60601-1 certified, or leakage testing must be completed 
by the end user for the alternate power adapter. Using an unapproved 
power adapter may result in an electric shock hazard and possible 
personal injury.

10. Use of cables or accessories other than those delivered with the 
system may result in increased emissions and/or decreased immunity 
of the Krios System and may result in personal injury.

11. The Krios System requires special precautions regarding EMC. It 
must be installed and put into service in accordance with the EMC 
information, detailed in this chapter. Failure to do so may result in 
personal injury.

12. Radio frequency communications equipment, including portable and 
mobile devices, may affect the Krios System and result in personal 
injury.

13. Do not use the Krios System either adjacent to, or stacked with, other 
equipment. Check that the Krios System is operating normally if it is 
used either adjacent to, or stacked with, other equipment. Failure to 
do so may result in personal injury.

Cautions

Caution! In all NDI documentation, cautions are marked with the word 
"Caution!" Follow the information in the accompanying paragraph to 
avoid damage to equipment.

1. Do not use aerosol sprays near the equipment as these sprays can 
damage circuitry.

2. Do not use any solvent to clean the Krios System. Solvents may 
damage the finish and remove lettering. 
Krios User Guide - Revision 03 v



Contact Information

If you have any questions regarding the content of this guide or the 
operation of this product, please contact us:

Updates

NDI is committed to continuous improvements in the quality and 
versatility of its software and hardware. To obtain the best results with 
your NDI system, check the NDI Support Site regularly for updated 
information:

https://support.ndigital.com
vi Krios User Guide - Revision 03
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1 System Overview

This guide provides details on the installation and use of the NDI 

Polaris® Krios System.

The intended use of the Krios Scanner is as a hand held digitizing camera 
for rigid body tracking and coordinate transformations within a reference 
frame. The Krios System does not require any specialised training or 
knowledge to be operated.

There are no contra-indications for using the Krios System.

Each electrode is mapped in imaging software, saving significant setup 
time. This automated registration process also improves the accuracy of 
source-localization. The system can also capture and store digital pictures 
of the procedure or experiment, to form part of a record within the 
application software.

1.1 System Components

The Krios System consists of the following parts: 

Krios Scanner
Part Number 8701087

Mounting Bracket Part Num-
ber 8701325

Host USB Converter (HUC)
Part Number 8800810.005

pruggeri
Highlight

pruggeri
Highlight

pruggeri
Highlight

pruggeri
Highlight

pruggeri
Highlight

pruggeri
Highlight



2 Krios User Guide - Revision 03

Note:Do not attach any parts to the system that are not listed in the table 
above. Do not modify any system components.

Krios Scanner

The Krios Scanner is the main unit of the NDI Krios System, see Figure 
1-1. The Scanner houses the sensors and controls. It is connected to the 
host computer via the Host USB Converter through a keyed connector on 
bottom of the Scanner

Figure 1-1  Krios Scanner

Probe
Part Number 8701326

Power Adapter and cable 2 m 
Part Number 8001260

USB cable Part Number 
2600596 

NDI Krios software (on USB 
stick) Part Number 8801325

Retro-reflective Markers Part 
Number 2301186

Scan 
Trigger

Sensor

Sensor

Probe 
Button

LED Indicator 
Bar

Image Capture 
Button
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The Scanner serial number label shows the item ID, model, serial number 
and manufacture date of the Scanner. The label also incorporates the 
“Consult Operating Instructions” graphic. An example of the Scanner 
serial number label is shown in Figure 1-2.

Figure 1-2  Krios Scanner Serial Number Label

1.2 Mounting Bracket

The mounting bracket allows you to securely attach the scanner to a 
standard 1/4”-20 tripod mount. This is useful during probing mode. 

The mounting bracket fits around the scanner handle and is secured with 
a clamp (Figure 1-3). 

Figure 1-3  Mounting Bracket

Securing 
Clamp
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Host USB Converter

The Host USB Converter provides the interface between the Scanner, the 
power adapter, and the host computer: 

• The attached Scanner cable connects the Host USB Converter to 
the Scanner. 

• The power adapter and USB cable plugs into the Host USB 
Converter.

The Host USB Converter serial number label shows the item ID, model, 
serial number and manufacture date of the Host USB Converter. The 
label also incorporates the “Consult Operating Instructions” graphic. An 
example of the Host USB Converter serial number label is shown in

Figure 1-4  Host USB Converter Serial Number Label

Power Adapter

The system is powered by an NDI supplied power adapter. Disconnecting 
the power adapter removes power from the system.

The power adapter connects to the mains supply and provides DC power 
to the Scanner via the Host USB Converter. 

The laptop power adapter that is certified with this device is Lenovo 
42T4430. If a different laptop/computer is used, the power adapter 
must be IEC 60601-1 certified, or leakage testing must be completed 
by the end user for the alternate power adapter. Using an unapproved 
power adapter may result in an electric shock hazard and possible 
personal injury.
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Host Computer 

The host computer should meet the following minimum specifications:

• 1 GHz or faster 32-bit (x86) or 64-bit (X64) processor

• 1 GB RAM (32-bit) or 2GB RAM (64 bit)

• 20 GB available hard disk space 

• DirectX 9 graphics device with WDDM 1.0 or higher driver

• Operating system: Windows 7 (64 bit) and Windows 10 (64 bit)

• Screen resolution 1024 x 768 (1280 x 1024 recommended)

Software

Installation and use of the software is detailed in section 2.3. 

2 System Setup

This section details the setup procedures for the NDI Krios System. 

2.1 Connection Requirements

The Krios system must communicate with a host computer to pass 
measurement information to another application running on the host 
computer. 

The Krios system is connected via USB. There are no special connection 
or security requirements for USB; any USB connection 2.0 or above will 
suffice. There is no power used from the USB connector.

The intended information flow from the Programmable Electrical 
Medical Systems (PEMS) is included in the content of this manual. 

The severity of all connections related to hazardous situations are the 
responsibility of the system integrator. This is because there is no 
essential performance of the PEMS.

Note: It is possible that connection to any computer network could 
introduce new risks and require additional analysis. Furthermore, any 
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changes to the computer network including connection, disconnection, 
updates and upgrades to existing equipment could also lead to new risks 
that lead to additional analysis.

2.2 Hardware Connection

Connect the hardware as follows, see Figure 2-1:

Position the system components so that they can be easily 
disconnected from mains power. Failure to do so may result in an 
electric shock hazard and possible personal injury.

1. Connect the integral cable on the USB adapter to the Scanner 
connector, located on the handle. Align the red mark on the Scanner 
connector with the corresponding red mark on the cable connector 
(the double keys of the connectors will be aligned).

Figure 2-1  Hardware Connection

Note:Only use the 3 m USB cable that is supplied with the system.

USB Connector B plug

Mains
Supply

Power Connector

Comm. Indicator

Power Indicator

Power
Adapter

USB Cable
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2. Connect the USB cable B plug and power supply cable to the USB 
adapter. Locate the top and bottom cable covers in place on the USB 
adapter. Secure the covers with the thumbscrew, see Figure 2-2.

Figure 2-2  Connecting Cables to the USB Adapter

3. Plug the USB cable A plug into the host computer.

4. Make sure all the cables are connected firmly, and placed where they 
will not be stressed, stepped on, or bent.

5. Plug the power cable into the power adapter.

Do not use a power bar or extension cable to connect the power 
adapter to the mains supply. Doing so may result in an electric shock 
hazard and possible personal injury.

Make sure the power adapter is connected to a mains supply with 
protective earth. Failure to do so may result in an electric shock 
hazard and possible personal injury.

6. Plug the power cable into the power mains and turn on the mains.

Top Cable Cover

Bottom Cable Cover

Power Supply
Cable

USB Cable B 
plug

Scanner 
Cable

Thumbscrew
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7. The Scanner will begin a diagnostic evaluation. When the diagnostic 
evaluation is complete, the Scanner will emit two beeps.

8. The USB adapter indicators will light as follows, see Figure 2-1:

• The power indicator lights green when power is applied to the 
system. 

• The communications indicator lights orange if there is a 
communication problem between the host computer and the 
system. It also flashes once when the USB adapter is first 
switched on.

The power adapter must be located outside the patient environment 
under all operating conditions. It is the responsibility of the system 
integrator and/or the end-user to ensure that the system is 
appropriately configured for the operating conditions.

2.3 Software Installation

To install the NDI Krios application, proceed as follows:

1. Run install.exe.

2. Follow the Installation Wizard to install the NDI Krios application. 

After installation, the NDI Krios   icon is placed on the desktop.

Note:Installing the NDI Krios application also installs the drivers for the USB 
adapter. The default installation location is: C:\Program Files 
(x86)\Northern Digital Inc.\Krios\USB Driver.

Host USB Drivers

You must install drivers when you first connect the NDI Host USB 
Converter to the host computer. There are two sets of drivers for the NDI 
Host USB Converter:

• the first set of drivers enables the NDI Host USB Converter to 
work with the host computer

pruggeri
Highlight

pruggeri
Highlight

pruggeri
Highlight

pruggeri
Highlight

pruggeri
Highlight



Krios User Guide - Revision 03 9

• the second set of drivers sets up the USB port where the NDI 
Host USB Converter adapter is connected to emulate a serial 
port

The USB drivers are downloaded as part of the NDI Krios installation. 
The default download location is:

• C:\Program Files (x86)\Northern Digital Inc.\Krios\USB Driver

Driver Installation - Windows 7/10   Install the drivers for Windows 7/10 as 
follows:

1. When you first connect the NDI Host USB Converter to the host 
computer, an error message may appear over the task bar. Ignore the 
message and complete the following steps to install the USB drivers. 

2. From the Windows menu, select “Control Panel”.

3. In the top right hand corner of the Control Panel window, select 
“View by: Small Icons”.

4. From the Control panel, select “Device Manager”.

5. Under Other Devices, right click NDI Host USB Converter. 

6. Select “Update Driver Software...” then select “Browse my computer 
for driver software”.

7. Select “C:\Program Files\Northern Digital Inc.\Krios\USB Driver”. 
Select “Next”.

8. In the Windows security dialog, select “Install this driver software 
anyway” option. The first set of drivers will install.

9. After the first set of drivers are installed, browse to “Other Devices” 
and right click USB Serial Port.

10. Select “Update Driver Software...”, then select “Browse my 
computer for driver software”.

11. Select “C:\Program Files\Northern Digital Inc.\Krios\USB Driver”. 
Select “Next”.

12. In the Windows security dialog, select “Install this driver software 
anyway” option. The second set of drivers will install.

Driver installation is complete and the system will now appear to be 
connected through a virtual COM port.
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Note:If you connect the Scanner to a different USB port, you will be prompted 
to re-install the drivers.
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3 Operation

This section details the operating procedures for the NDI Krios System. 

3.1 Overview

Operation of the NDI Krios System comprises a number of discrete steps 
as follows:

• Set up scanning environment.

• Attach each electrode (with prefixed 
marker) to the scalp or cap.

• Scan the head with the Krios Scanner 
to localise each marker’s position. This 
process creates a digital point cloud 
(3D model) and rigid body of marker 
coordinates.

• Probe anatomical features to 
establish fiducial (reference) points, 
such as the nasion, inion and 
preauricular points.

• Apply transformation to define an 
appropriate coordinate system for 
the point cloud.

• Label each marker to create a 
template of the labelled point cloud.

• Export the results as a .csv file.

• (Optional) Capture and save a digital image.
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3.2 Scanning Environment

Choose a scanning environment that meets the following criteria

• Scan against a non reflective background that is in contrast to 
the object you are scanning. For example, scan a white object 
against a dark background.

• Remove, or drape any reflective or shiny surfaces in the area

• Remove, or mask, any personal reflective items, for example, 
metal watches, belt buckles. 

• Minimize exposure to infrared (IR) interference. (For example, 
sun light, ceiling lights and plasma monitors are all possible 
sources of infrared interference.)

3.3 Scanning Best Practices

To achieve the best possible result, follow the best practices detailed 
below:

Do not touch the subject and metal parts of the system at the same 
time. Doing so may result in an electric shock hazard and possible 
personal injury.

• Allow the Scanner to warm up for two minutes before use.

• Point the Scanner directly where you want to scan and move it 
back and forth at an even pace, in straight lines. Try not to rotate 
the camera left and right in your hand.

• As you scan markers and they become valid (white), move to 
adjacent markers, to sequentially build up the point cloud. If you 
“lose” the existing point cloud, you must re-acquire it before 
continuing. 

• Try to maintain a consistent distance (approx. 300 mm to 
400 mm) from the subject. If you get too close or too far, the 
display will zoom in or out to show that you need to reposition 
the Scanner.

• Plan a path to scan around the subject that will cover all the 
markers, checking that no markers are missed as you scan.
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3.4 Krios User Interface

The User Interface for the NDI Krios System is described below. 

Double click the  icon to start the NDI Krios. The system will auto-
connect by default. Alternatively, select File>Connect to and select the 
com port to which the system is connected.

Figure 3-1  Krios Application Interface

After initialising, the NDI Krios screen launches, see Figure 3-1. The 
current status is displayed at the bottom left of the screen. 

The Connected status of the system is displayed at the bottom right of 
the screen. 

The numerical count of the markers scanned is displayed at the bottom 
centre of the screen. 

Additional windows and the menu bar are described below.
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Menu Bar

The menu bar provides the following controls, see Figure 3-2.

Figure 3-2  Menu Bar

1. Import - import a previously recorded session.

2. Template - import a previously recorded session for use as a 
template for labelling purposes.

3. Tool - select the applicable .rom file for the probe.

4. Export - export the session to one of 4 file types. See the section 
3.10 for details.

5. Scan - switches to Scan mode (You can also select Scan mode using 
the Scan trigger on the Scanner, see “Krios Scanner” on page 2.)

6. Probe - select probing mode (active only after 10 or more markers 
have been scanned.)

7. Delete - delete the current session.

8. Transform - transforms the coordinate system from global to the 
probed anatomical (fiducial) points.

9. Label - open the Label Assist window to use a template to label a 
new session.

10. Clear - remove labels from the current session.

11. Show Missing Labels - display markers missing from current 
session when compared to template.

Legend

The legend window details the marker colour definitions. 

Label Selected Marker

The Label Selected Marker window provides the following information
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Marker ID - displays the (automatically assigned) number of the 
selected marker.

Reference - a text field that allows you to specify a name for the 
selected marker.

Special Marker - a drop-down list that allows you to designate the 
selected marker as a special marker.

Type - allows you to view the type of marker.

Processing

The Processing window displays the status and prompts for the current 
activity.

3.5 Attach the Markers

Attach the self-adhesive markers either directly to the scalp or to the 
sensor to be measured (e.g. electrodes for EEG or optodiodes for NIRS).

3.6 Scan the Markers

To scan the markers, follow the procedure detailed below:

1. Make sure the Scanner is connected and the software is installed as 
detailed in “System Setup” on page 5. 

2. Make sure the scanning environment meets the criteria detailed in 
“Scanning Environment” on page 12.

3. Double click the  icon to start the NDI Krios software. The 
system will auto-connect by default. Alternatively, select 
File>Scanner Connection and select the com/serial port to which 
the system is connected.

Note:If the system has been previously connected, it will automatically 
reconnect at start up. To disable this feature deselect File>Connect 
Options>Reconnect on Start.



16 Krios User Guide - Revision 03

4. Press and hold the Scan trigger to start scanning, see Figure 1-1. 
Alternatively you can double-click the trigger to start or stop 
scanning. This removes the requirement to keep the button pressed

Move the Scanner while watching the visual representation of the 
markers on the monitor. Continue scanning until all markers have 
been scanned. Make sure the subject remains in the Scanner Field-of 
View, see Figure 3-4.
As you scan, the markers will change colour as follows:

• Yellow - marker is currently visible to the Scanner

• Red - marker is stray. Not yet valid or scanned

• White - marker is valid/scanned 

• Purple - probed marker

• Green - special user defined marker (fiducial)

• Pink - missing marker (not applicable during scanning)

• Black - marker is unmatched (not applicable during scanning)

Figure 3-3 shows an example of a scan in progress.

Note:The number of markers scanned (displayed at the bottom of the window) 
will show total number of markers to be scanned if a template is loaded. 
For example 82/256.
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Figure 3-3  Scan in Progress 

Use the mouse controls as follows to manipulate the view:

• Left click and drag rotates the view

• Middle click and drag to pan the view

• Right click and drag to zoom the view in and out

If sounds is enabled, audio tones will alert you when you are too close or 
too far from the subject. A low pitch tone will indicate that you are too far 
and a higher pitch tone indicates you are too close. Additionally, the 
display will zoom out when you are too far and zoom in when you are too 
close. Complete a few practice scans to become familiar with each tone 
and the scanning technique. 
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Figure 3-4  Krios Field of View

The Scanner incorporates an LED status bar that provides visual 
indications as shown in Table 3-1.

Table 3-1:  Scanner LED Status

Status LED State

Warming Up Fading in/out White

Power Up White

Connected and 
software running

Solid Blue

Scanning Fading in/out Blue

Too close/too far Fading in/out Orange

Lost Solid Orange

883 mm

928 mm

840 mm

105 mm - Stand-off 
from Scanner to Front 
of Field of View
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As each marker is acquired it will be added to the visual representation 
and the number of markers, shown on the bottom of the screen, will 
increment. Each scanned marker will automatically be assigned an ID 
number.

Continue scanning until all markers are acquired, then click Done. (You 
can click Pause and Continue as required during the scanning process.)

5. Continue to probing mode below. 

3.7 Probing

Probing mode uses a probe to define fiducial points on anatomical 
features relative to the scanned markers (i.e. co-registration). 
Additionally, when in continuous mode, it can provide a surface profile of 
anatomical features.

While in probing mode, the probe is represented dynamically in the main 
window and measurement volume. (The measurement volume is 
represented on the right of the screen, see Figure 3-5.) 

Probing Modes

Probing can either be by single point or continuous. The difference 
between single point and continuous probing is the trigger method:

• Single point mode is initiated by either:

- Selecting the Probe button on the Scanner, see Figure 1-1

or

- Holding the probe stationary for two seconds. 

• Continuous mode records points automatically as soon as the 
probe is in view. 

Set the required probing mode in Preferences, see “Preferences” on 
page 28.
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Set Probe tool definition

For the system to recognize a probe, its corresponding tool definition 
must be loaded into the application. The system will retain this definition 
and you only have to repeat this step if a new tool with different marker 
geometry is required. 

To Load a tool definition, select the Tool icon . From the resulting 
dialog, select the .rom file that matches the probe you intend to use. If the 
correct .rom file is not visible, navigate to and select the correct file.

Probing Procedure

Note:It is useful to clamp the Scanner during the probing process. This leaves 
both hands free for probing. 

1. Move the probe into the measurement volume. The probe will be 
represented dynamically in the main window and in the 
measurement volume.

Note:You can also select Probe mode from the Probe button on the Scanner, 
see Figure 1-1.
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Figure 3-5  Probing in Progress

2. In Probe mode, the application provides prompts to guide you 
through the process. 

The Probe dialog also displays self explanatory messages as required 
during the process, for example “Probe Missing” when the probe is 
not visible to the Scanner.
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3. When you have probed all required points, select Done. The probed 
points will change to light blue, see Figure 3-6.

Figure 3-6  Probing Complete 

3.8 Transform the Coordinate System

Once scanning and probing is complete, point cloud coordinates will be 
displayed in the Krios coordinate system. They are arbitrarily defined, 
based on the first four points scanned. You can choose to define an 
anatomically relevant coordinate system for the point cloud based on 
fiducial points using the Transform function. Follow the steps below to 
complete the transform.

1. Select individual markers as required with the left mouse button and 
designate them as special markers (fiducial points) from the Special 
Marker drop-down list. The selected marker will change to green. 
(see Figure 3-7 for an example of a Transform in progress.)

You can also select any marker and assign text to it. Left-click the 
required marker. Double clicking a marker will place the cursor 
directly into the Reference field. Enter text in the Reference field. 
The text will appear on the selected marker.
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Figure 3-7  Transform - In Progress

2. Once the Nasion, Left Preauricular Point and Right Preauricular 
Point have all be defined, select the Transform button on the toolbar 
to transfer the point cloud coordinates from the Krios coordinate 
system to the standard head coordinate system. (See Figure 3-8 for 
an example of a completed Transform.)
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Figure 3-8  Transform - Complete

3. Export the completed session as detailed in the section Export 
Results on page 27.

3.9 Labelling the Point Cloud

If a labelling template has previously been created, the Label Assist 
function can be used to automatically label the point cloud by mapping 
against the template. If a labelling template has not yet been created, you 
can manually label the point cloud and save it as a template for future use.

Note:Scanning, probing and transforming must be complete before you begin 
to work with labelled templates.

To create a labelling template, you must manually label the point cloud 
by completing the following steps:

1. Select a marker in the point cloud. The selected marker turns yellow. 
See Figure 3-9.

2. In the Label Selected Marker pane, enter the label for the marker in 
the Reference text box. 
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3. Repeat steps 1 and 2 until all scanned markers in the point cloud 
have been given a unique label.

4. To save this fully labelled point cloud for use as a template, select 
Export to export the collected data as a .csv file. In the resulting 
dialog, specify the file name and location for the file.

Note:Ensure the point cloud coordinates have been transformed to the 
standard head coordinate system before exporting as a template.

Figure 3-9  Partially Labelled Point Cloud

Using a Labelled Template for Automatic Labelling 

To use a labelling template to automatically label a scanned point cloud, 
complete the following steps:

1. Select Template. In the resulting dialog, locate and double-click the 
.csv file containing the labelled template.

2. Select Label. This presents the Label Assist view, with the labelled 
template on the left and the unlabelled point cloud on the right. See 
Figure 3-10.
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Figure 3-10  Label Assist with Unlabelled Point Cloud

Note:Ensure the unlabelled point cloud coordinates have been transformed to 
the standard head coordinate system before entering the Label Assist 
view.

3. Working in the unlabelled point cloud, label four markers. For best 
results, these markers should be spread across the point cloud, not 
clustered together in the same area.

4. Once you have four markers labelled, click off the point cloud. The 
template is applied to the unlabelled point cloud, which becomes 
fully labelled. See Figure 3-11.
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Figure 3-11  Template Assist with Labelled Point Cloud

5. To exit the Label Assist view, select Label again.

Note:Dark grey unlabelled markers in the point cloud on the right following 
Step 5 indicate that Krios could not apply the template completely. This 
usually occurs when the initial four markers were labelled incorrectly or 
not spread out, or the transform was not performed correctly. You can 
attempt to manually correct the errors or clear all labels by selecting 
Clear, and restart the labelling process.

3.10 Export Results

Select Export to export the collected data. There are four different export 
options.

• .csv is the standard format used by NDI

• .ela and .sfp are file formats for BESA

• .rom is for use in other NDI measurement tools

Only .csv files can be imported back into the RapidMarkr software.
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3.11 Image Capture

Capture an image of the Scanner view as follows:

Press the Image Capture button on the Scanner, see Figure 3-12. The 
Image Capture window launches and displays a progress bar. 

After the image capture is complete, the file is automatically saved to 
the working directory. The format is .png. 

Figure 3-12  Image Capture Button

4 Preferences

You can access preferences to customize various Krios settings. 

1. Select File>Preferences... . The Preferences dialog opens. 

2. Set as required in each field.

Figure 4-1  Krios Preferences

Image Capture 
Button
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5 Maintenance

User maintenance of the Krios System is limited to cleaning.

There are no user serviceable parts in the Krios System. All servicing 
must be done by NDI. Unauthorised servicing may result in personal 
injury.

Do not immerse the Krios System in liquids, or allow fluid to enter the 
equipment in any way. Exposing the Krios System to liquids may 
result in equipment damage, produce a fire or shock hazard, and 
result in personal injury.

Switch off power to the Krios System before cleaning it. Failure to do 
so may result in personal injury.

Caution! Do not use aerosol sprays near the equipment as these sprays can 
damage circuitry.

Do not use any solvent to clean the Krios System. Solvents may 
damage the finish and remove lettering. 

To clean the Krios System proceed as follows:

1. Wipe off dust with a dry, soft cloth.

2. Remove dirt or finger marks using a damp cloth and dry immediately 
with a clean cloth.

3. If required, gently remove any dust or finger marks from the lenses 
using a microfibre lens cleaning cloth.
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5.1 Disposal of Equipment

To ensure environmentally responsible disposal after the equipment is 
decommissioned, please contact NDI. See “Contact Information” on 
page vi.

6 Specifications

6.1 Operating Environmental Conditions

The power adapter must be located outside the patient environment 
under all operating conditions. It is the responsibility of the system 
integrator and/or the end-user to ensure that the system is 
appropriately configured for the operating conditions.

Table 6-1:  Operating Environmental Conditions

Environmental Condition Value

Atmospheric Pressure 70 kPa to 106 kPa

Relative Humidity 30% to 75%

Temperature +10°C to +30°C (see warning below)
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6.2 Transportation and Storage Environmental Conditions

6.3 Technical Specifications

Table 6-2:  Transportation and Storage Environmental Conditions

Environmental Condition Value

Atmospheric Pressure 50 kPa to 106 kPa

Relative Humidity 10% to 90% non-condensing

Temperature -10°C to +50°C

Table 6-3:  Krios Scanner Technical Specifications

Specification Value

Dimensions 300 mm x 75 mm x 155 mm

Weight 860 g

Update Frequency 20, 30, 60 Hz

Scan Rate 256 markers < 2 minutes

Accuracy Within 0.5 mm RMS

Table 6-4:  Host USB Converter Technical Specifications

Specification Value

Dimensions 88 mm x 57 mm x 39 mm

Weight 0.35 kg

Mounting Free standing or secured via three M6 x 
1 mm pitch x 3 mm deep threaded holes, 
located in the mounting feet

Input Voltage 24 VDC

Output Voltage 26 VDC

Power Consumption <2 W
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7 Approvals and Classifications

7.1 Approvals

Optical Radiation Safety

Scanner Illuminators

The Polaris Krios Scanner Sensor illuminators emit invisible LED 
radiation. The Polaris Krios System emits IR light that may interfere with 
IR controlled devices, such as operating room tables. It is recommended 
that you test the Polaris Krios System if you intend to use it in an 
environment where other IR controlled devices are in use. 

Table 6-5:  Power Adapter Technical Specifications

Specification Value

Model Advanced Power Solutions APS49EMG-
24021-7

Dimensions 125 mm x 62 mm x 32 mm

Weight 0.37 kg

Mounting Free standing

Input Voltage 100 VAC to 240 VAC

Input Frequency 50/60 Hz

Input Power 0.63 A - 1.2 A

Power Output 24 VDC @ 2.1 A
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7.2 Classifications

8 Electromagnetic Compatibility

The Krios System requires special precautions regarding EMC. It 
must be installed and put into service in accordance with the EMC 
information, detailed in this chapter. Failure to do so may result in 
personal injury.

Radio frequency communications equipment, including portable and 
mobile devices, may affect the Krios System and result in personal 
injury.

Do not use the Krios System either adjacent to, or stacked with, other 
equipment. Check that the Krios System is operating normally if it is 
used either adjacent to, or stacked with, other equipment. Failure to 
do so may result in personal injury.

Table 7-1   Classifications

Classification Description

Electric shock protection Class I - no applied parts

Degree of protection from electric 
shock

Not classified

Ordinary Equipment IPX0

Flammable atmosphere Not suitable for use in the 
presence of a flammable 
anaesthetic mixture with air, 
oxygen or nitrous oxide

Mode of operation Continuous when supplied by 
mains

Method of sterilization or 
disinfection

Not suitable for sterilization

IRED illuminators risk group Exempt
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This chapter contains the following information about the 
electromagnetic compatibility of the system:

• “Cables and Accessories” on page 34

• “Guidance and Manufacturer’s Declaration: Electromagnetic 
Immunity” on page 35

• “Recommended Separation Distances” on page 38

• “Radio Frequency Emissions” on page 39

8.1 Cables and Accessories

Only those cables and accessories delivered with the system may be used 
with the Krios System while still maintaining compliance to the 
emissions and immunity requirements of IEC 60601-1-3.

Use of cables or accessories other than those delivered with the 
system may result in increased emissions and/or decreased immunity 
of the Krios System and may result in personal injury.Guidance and 
Manufacturer's Declaration: Electromagnetic Emissions

8.2 Guidance and Manufacturer’s Declaration: Electromagnetic 
Emissions

The Krios System is intended for use in the electromagnetic environment 
specified below. The customer or the user of the Krios System should 
assure that it is used in such an environment.

Table 8-1   Manufacturer’s Declaration for Electromagnetic Emissions

Emissions Test Compliance Electromagnetic Environment Guidance

RF emissions 
CISPR11

Group 1 The Krios System uses RF energy only for its internal 
function. Therefore, its RF emissions are very low 
and are not likely to cause any interference in nearby 
electronic equipment.
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8.3 Guidance and Manufacturer’s Declaration: Electromagnetic 
Immunity

The Krios System is intended for use in the electromagnetic environment 
specified below. The customer or the user of the Krios System should 
assure that it is used in such an environment.

RF emissions 
CISPR11

Class B The Krios System is suitable for use in all establish-
ments, including domestic establishments and those 
directly connected to the public low-voltage power 
supply network that supplies buildings used for 
domestic purposes.

Harmonic emis-
sions IEC61000 3-2

Class A

Voltage fluctuations/
flicker emissions 
IEC61000-3-3

Complies

Table 8-1   Manufacturer’s Declaration for Electromagnetic Emissions

Table 8-2:  Electromagnetic Immunity

Immunity Test
IEC 60601 Test 
Level

Compliance 
Level

Electromagnetic 
Environment - Guidance

Electrostatic dis-
charge (ESD)
IEC 61000-4-2

±6 kV contact
±8 kV air

±6 kV contact
±8 kV air

Floors should be wood, con-
crete or ceramic tile. If floors 
are covered with synthetic 
material, the relative humid-
ity should be at least 30%.

Electrical fast tran-
sient/burst 
IEC 61000-4-4

±2 kV for power 
supply lines.
±1 kV for input/
output lines

±2 kV for 
power supply 
lines.
±1 kV for 
input/output 
lines

Mains power quality should 
be that of a typical commer-
cial or hospital environment.

Surge 
IEC 61000-4-5

±1 kV line(s) to 
line(s)

±1 kV differen-
tial mode

Mains power quality should 
be that of a typical commer-
cial or hospital environment.

±2 kV line(s) to 
earth

±2 kV com-
mon mode
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Note:UT is the a.c. mains voltage prior to application of the test level.

Voltage dips, short 
interruptions and 
voltage variations 
on power supply 
input lines
IEC 61000-4-11

<5% UT 
(>95% dip in UT)

for 0.5 cycles

<5% UT 
(>95% dip in 
UT)

for 0.5 cycles

Mains power quality should 
be that of a typical commer-
cial or hospital environment. 
If the user of the Krios Sys-
tem requires continued opera-
tion during power mains 
interruptions, it is recom-
mended that the Krios Sys-
tem be powered from an 
uninterruptible power supply 
or a battery.

40% UT 
(60% dip in UT)

for 5 cycles

40% UT 
(60% dip in 
UT)

for 5 cycles

70% UT 
(30% dip in UT)

for 25 cycles

70% UT 
(30% dip in 
UT)

for 25 cycles

<5% UT 
(>95% dip in UT)

for 5 s

<5% UT 
(>95% dip in 
UT)

for 5 s

Power frequency 
(50/60Hz) mag-
netic field IEC 
61000-4-8

3 A/m 3 A/m Power frequency magnetic 
fields should be at levels 
characteristic of a typical 
location in a typical commer-
cial or hospital environment. 

Table 8-2:  Electromagnetic Immunity (Continued)

Immunity Test
IEC 60601 Test 
Level

Compliance 
Level

Electromagnetic 
Environment - Guidance
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At 80 MHz and 800 MHz, the higher frequency range applies. 

These guidelines may not apply to all situations. Electromagnetic 

Table 8-3:  Electromagnetic Immunity—Not Life Supporting

Immunity 
Test

IEC 
60601 
Test 
Level

Compliance 
Level

Electromagnetic Environment - 
Guidance

Conducted 
RF 
IEC 
61000-4-6

3 Vrms
150 kHz 
to 
80 MHz

3 V Portable and mobile RF communications equip-
ment should be used no closer to any part of the 
Krios System, including cables, than the recom-
mended separation distance calculated from the 
equation applicable to the frequency of the trans-
mitter.
Recommended separation distance:
d = 1,2√P
See Table 8-4 on page 38.

Radiated 
RF 
IEC 
61000-4-3

3 V/m
80 MHz 
to 
2,5 GHz

3 V/m d = 1,2√P 80 MHz to 800 MHz

d = 2,3√P 800 MHz to 2,5 GHz

See Table 8-4 on page 38.

Where 'P' is the maximum output power rating of 
the transmitter in watts (W) according to the 
transmitter manufacturer and 'd' is the recom-
mended separation distance in metres.
Field strengths from fixed RF transmitters, as 

determined by an electromagnetic site surveya, 
should be less than the compliance level in each 

frequency rangeb. Interference may occur in the 
vicinity of equipment marked with the following 
symbol:
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propagation is affected by absorption and reflection from structures, 
objects, and people.

a - Field strengths from fixed transmitters, such as base stations for radio 
(cellular/cordless) telephones and land mobile radios, amateur radio, AM 
and FM radio broadcast and TV broadcast, cannot be predicted 
theoretically with accuracy. To assess the electromagnetic environment 
due to fixed RF transmitters, an electromagnetic site survey should be 
considered. If the measured field strength in the location where the Krios 
System is used exceeds the applicable RF compliance level above, 
observe the Krios System to verify normal operation. If abnormal 
performance is observed, additional measures may be necessary, such as 
re-orienting or relocating the Krios System.

b - Over the frequency range of 150 kHz to 80 MHz, field strengths 
should be less than 3 V/m.

8.4 Recommended Separation Distances 

The Krios System is intended for use in an electromagnetic environment 
in which radiated RF disturbances are controlled. The customer or the 
user of the Krios System can help prevent electromagnetic interference 
by maintaining a minimum distance between portable and mobile RF 
communications equipment (transmitters) and the Krios System, as 
recommended below, according to the maximum output power of the 
communications equipment.

Table 8-4:  Recommended Separation Distances between Portable and  Mobile 
RF Communications Equipment and the Krios System

Rated maximum 
output power of 
transmitter (watts)

Separation distance according to frequency of 
transmitter (metres)

150 kHz to 80 
MHz
d = 1,2√P

80 MHz to 800 
MHz
d = 1,2√P

800 MHz to 2.5 GHz
d = 2,3√P

0,01 0,12 0,12 0,23

0,1 0,38 0,38 0,73

1 1,2 1,2 2,3



Krios User Guide - Revision 03 39

For transmitters rated at a maximum output power not listed above, the 
recommended separation distance (d) in metres (m) can be estimated 
using the equation applicable to the frequency of the transmitter, where P 
is the maximum output power rating of the transmitter in watts (W) 
according to the transmitter manufacturer.

Note:At 80 MHz and 800 MHz, the higher frequency range applies. 

These guidelines may not apply to all situations. Electromagnetic 
propagation is affected by absorption and reflection from structures, 
objects, and people.

8.5 Radio Frequency Emissions

FCC

This device complies with Part 15 of the FCC rules. Operation is subject 
to the following two conditions:

1. This device may not cause harmful interference and,

2. This device must accept any interference received, including 
interference that may cause undesired operation.

Note:This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference 
will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be 

10 3,8 3,8 7,3

100 12 12 23

Table 8-4:  Recommended Separation Distances between Portable and  Mobile 
RF Communications Equipment and the Krios System
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determined by turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the following 
measures: 
— Reorient or relocate the receiving antenna. 
— Increase the separation between the equipment and receiver. 
— Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected. 
— Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by Northern Digital Inc. 
could void the user’s authority to operate the equipment. 

CE Mark

CE Mark: This is a Class B product. In a domestic environment, this 
product may cause radio interference, in which case the user may be 
required to take adequate measures. 

Industry Canada

Industry Canada Compliance Statement: This ISM device complies with 
Canadian ICES-001.

Avis de Conformité à la réglementation d’Industrie Canada: Cet appareil 
ISM est conforme à la norme NMB-001 du Canada.
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